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はじめに

以下のトピックでは、Cisco Prime Unified Operations Manager（Prime UOM）の使用を開始するため

の方法について、作業ごとに説明します。

• 「Prime UOM の設定作業の実行」（P.2-1）

• 「Prime UOM の設定」（P.2-3）

• 「デバイスをモニタするための Operations Manager の設定」（P.2-4）

• 「デバイス収集前のデバイスの設定」（P.2-18）

• 「音声アプリケーション システムおよびソフトウェアの使用」（P.2-27）

• 「Prime UOM のカスタマイズ」（P.2-20）

ワンポイント アドバイス Prime UOM についてのオンラインのビデオ チュートリアルを見るには、オンライン ヘルプの 
[E-Learning] アイコンをクリックします。

Prime UOM の設定作業の実行 

Prime UOM でネットワーク上のユニファイド コミュニケーション デバイスを監視するためには、必要

な設定作業が多数あります。導入形態に応じて次のフローチャートを使用し、Prime UOM を使用して

ユニファイド コミュニケーション ネットワークを監視するために必要な作業を確認してください。設

定が終了すれば、データの収集、レポートの実行、ネットワークに影響を及ぼすおそれのある重大なデ

バイス イベントの監視を行えるようになります。

導入形態に応じた設定作業フローチャートを使用してください。

• 「エンタープライズ バージョン導入の設定タスク」（P.2-2）

• 「マルチ エンドカスタマー バージョン向けの設定作業」（P.2-3）
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エンタープライズ バージョン導入の設定タスク

ここでは、Prime UOM のエンタープライズ バージョンを使用してユニファイド コミュニケーション 
ネットワークの監視を始める前に、実行する必要のある作業について説明します。

図 2-1 エンタープライズ バージョンの導入のための設定作業
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    Prime UOM の設定
マルチ エンドカスタマー バージョン向けの設定作業

ここでは、Prime UOM のマルチ エンドカスタマー バージョンを使用してユニファイド コミュニケー

ション ネットワークの監視を始める前に、実行する必要のある作業について説明します。

図 2-2 マルチ エンドカスタマー バージョンの導入の場合の設定作業

Prime UOM の設定
この項では、Prime UOM を正しく使用するために必要な作業について説明します。

• 「デバイスをモニタするための Operations Manager の設定」（P.2-4）

• 「Prime UOM からの Cisco Unified Communications Management Server リンクの追加」（P.2-22）

• 「セキュリティの概要と設定について」（P.2-22）

• 「SNMP トラップの受信とフォワーディングの設定」（P.2-23）
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• 「Health Monitor の設定」（P.2-25）

• 「Internet Explorer 信頼済みサイト ゾーンへの Operations Manager ホームページの追加」（P.2-26）

• 「Prime UOM サーバの DSCP トラフィックの優先順位付けの設定」（P.2-26）

デバイスをモニタするための Operations Manager の設定
Prime UOM は、Common Services Device and Credentials Repository (DCR) から監視するデバイスを

取得します。DCR は、デバイスおよびそのクレデンシャルの共通リポジトリで、個々のアプリケー

ションによって使用されます。

この項の構成は、次のとおりです。

• DCR のモード（マスターおよびスレーブ）の設定

• DCR へのデバイスの追加

• DCR へのデバイスのインポート

• DCR から Operations Manager への手動によるデバイスの追加

• デバイスの状態について

• Prime UOM に追加したデバイスの確認

• インベントリ収集のスケジュール

• デバイス インポートおよびインベントリ収集のトラブルシューティング

• デバイスの設定とクレデンシャルの編集

• SNMP タイムアウトと再試行の変更

• 「デバイスのインベントリ収集の手動実行」（P.2-17）

Prime UOM でデバイスをモニタするには、あらかじめデバイスを DCR に追加しておく必要がありま

す。デバイスを DCR に追加した後は、DCR とは別の Prime UOM インベントリにデバイスを追加する

ことができます。

（注） Prime UOM エンタープライズ バージョンは、インストールすると自動的に DCR と同期し、インベン

トリを追加します。これがデフォルト設定です。マルチ エンドカスタマー バージョンのインストール

では、デバイスは手作業で追加する必要があります。

エンタープライズ バージョンの場合は、自動同期を有効にすると、デバイスが DCR から Prime UOM 
に自動的に追加されます（デフォルト）。[Device Selection] ページから手作業で追加することもできま

す。

マルチ エンド カスタマー バージョンの場合、[Device Add] ページまたは [Device Import] を使用して

手動で追加できます。Prime UOM が DCR から受ける影響の詳細については、Device and Credentials 
Repository（DCR）についてを参照してください。

NMSROOT ディレクトリは、ウイルス スキャンから除外する必要があります。ウイルス スキャンが原

因でファイルがロックされていると、問題が発生することがあります。

NMSROOT は、Prime UOM がインストールされているシステム上のディレクトリです。インストール

中にデフォルト ディレクトリを選択した場合は、C:\PROGRA~1\CSCOpx となります。
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    デバイスをモニタするための Operations Manager の設定
表 2-1 に、考えられるいくつかの Prime UOM 展開シナリオと、デバイスを Prime UOM インベントリ

に追加するために必要な作業を示します。

表 2-1 デバイスをインベントリに追加するシナリオ

導入シナリオ 対処法

• Prime UOM を独立したサーバとして配置する。

• インベントリを DCR と自動的に同期させる。

自動同期を使用してデバイスを DCR から追加します。自動

同期はデフォルトの設定です。1

同期の設定を自動から変更した場合は、設定を元に戻す必要

があります。「Operations Manager の自動デバイス選択の設

定」（P.2-12）を参照してください。

• Prime UOM を独立したサーバとして配置する。

• インベントリに追加するデバイスを手動で制御する。

デバイスを DCR から手動で追加します。「DCR から 
Operations Manager への手動によるデバイスの追加」

（P.2-12）を参照してください。

• Prime UOM を独立したサーバとして配置する。

• 自動検出を使用していますが、自動検出によって検出さ

れたすべてのデバイスを Prime UOM で管理する必要は

ありません。

• 自動同期を使用してデバイスを DCR から追加します。1

• 設定したパラメータに基づいてデバイスが選択されるよ

うに自動同期を設定します。「Operations Manager の自

動デバイス選択の設定」（P.2-12）を参照してください。

• Prime UOM を CiscoWorks LAN Management Solution
（LMS）とともに配備する。

• Prime UOM DCR をマスター DCR として使用する。

• インベントリを DCR と自動的に同期させる。

• Prime UOM DCR をマスターとして設定し、LMS DCR 
をスレーブとして設定します。「DCR のモード（マス

ターおよびスレーブ）の設定」（P.2-6）。

• 物理ディスカバリを実行します。「DCR へのデバイスの

追加」（P.2-7）を参照してください。

• Prime UOM に自動同期が設定されていることを確認し

ます。「Operations Manager の自動デバイス選択の設定」

（P.2-12）を参照してください。
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DCR のモード（マスターおよびスレーブ）の設定

デフォルトでは、Prime UOM サーバの DCR はスタンドアロンまたは独立リポジトリとして設定され

ています。DCR を Prime UOM に対してマスターまたはスレーブとして設定する場合、その手順は 
CiscoWorks のオンライン ヘルプに記載されています。

CiscoWorks のオンライン ヘルプにアクセスするには、Operations Manager のホームページで 
[Administration] を選択し、見出し（[CiscoWorks/Common Services]）の下にある任意のリンクを選

択します。新しいウィンドウが開いたら、[Help] リンクをクリックします。

Prime UOM および CiscoWorks が互換性のあるバージョンであることを確認してから、マスター モー

ドとスレーブ モードを設定します。互換性の詳細については、『Supported and Interoperable Devices 
and Software Table for Cisco Unified Operations Manager 8.0』を参照してください。

前提条件となる作業を実行し、適切な順序でマスターおよびスレーブに設定する必要があります。次の

手順は、作業を開始し、オンライン ヘルプで必要な情報を探し出すのに役立ちます。

（注） Operations Manager を起動するには、「Prime UOM の起動」（P.1-30）を参照してください。

• Prime UOM を LMS とともに配備する。

• Prime UOM DCR を既存のマスター DCR と同期させる。

• インベントリを DCR と自動的に同期させる。

• Prime UOM サーバの DCR をスレーブとして設定し、い

ずれか 1 つの LMS DCR をマスターとして設定します。

「DCR のモード（マスターおよびスレーブ）の設定」

（P.2-6）。

• デバイスがマスター DCR に追加されるように Prime 
UOM を設定します。「DCR へのデバイスの追加」

（P.2-7）を参照してください。

• 物理ディスカバリを実行します。「DCR へのデバイスの

追加」（P.2-7）を参照してください。

• Prime UOM に自動同期が設定されていることを確認し

ます。「Operations Manager の自動デバイス選択の設定」

（P.2-12）を参照してください。

• Prime UOM を LMS とともに配備する。

• Prime UOM を既存のマスター DCR と同期させる。

• Prime UOM で管理するデバイスを手動で制御する。

• Prime UOM サーバの DCR をスレーブとして設定し、

LMS サーバの DCR をマスターとして設定します。

「DCR のモード（マスターおよびスレーブ）の設定」

（P.2-6）。

• デバイスがマスター DCR に追加されるように Prime 
UOM を設定します。「DCR へのデバイスの追加」

（P.2-7）を参照してください。

• 物理ディスカバリを実行します。「DCR へのデバイスの

追加」（P.2-7）を参照してください。

• Prime UOM に手動同期が設定されていることを確認し

ます。「Operations Manager の自動デバイス選択の設定」

（P.2-12）を参照してください。

1. ネットワーク デバイスにデバイス クレデンシャルを設定済みであることを確認してください。

表 2-1 デバイスをインベントリに追加するシナリオ （続き）

導入シナリオ 対処法
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DCR をマスター モードおよびスレーブ モードに設定する手順は次のとおりです。

ステップ 1 [Administration] > [Device and Credentials (Common Services)] > [Administration] を選択します。

[Common Services] ウィンドウが開きます。

ステップ 2 左ペインにある [Mode Settings] リンクをクリックします。

[Mode Settings] ウィンドウが表示されます。

ステップ 3 このページの右上隅にある Help リンクをクリックします。マスターとスレーブの設定の前提条件を実

行する手順を検索します。次の作業を行います。

• マスター DCR によるシステムへのピア サーバ ユーザの追加

• スレーブ DCR によるシステム上でのシステム ID ユーザの作成

• セキュリティ証明書のコピー 

Common Services のオンライン ヘルプの手順に従って前提条件を確認し、正しい順序でマスターおよ

びスレーブに設定します。

DCR へのデバイスの追加 
デバイスを DCR に追加するには、[Prime UOM Add Devices] ページ（[Administration] > [Device 
Management] > [Device Configuration] > [Add Devices]）を使用します。

この項の構成は、次のとおりです。

• Operations Manager の物理ディスカバリの設定

• クレデンシャルの設定

• Operations Manager の物理ディスカバリのフィルタリング

（注） バルク インポート（NMS またはファイルからのインポート）を使用して DCR にデバイスを追加する

には、「DCR へのデバイスのインポート」（P.2-11）を参照してください。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [Add Devices] を選択します。

[Add Devices] ページが表示されます。

ステップ 2 次を入力します。

• IP アドレスまたはホスト名。カンマ区切りのリストを使用して、複数のデバイスを同時に入力で

きます。デバイスのホスト名は DNS で解決できる名前を指定してください。複数のデバイスを一

緒に追加するときは、すべてのデバイスが同じタイプであり、同じクレデンシャルを使用している

必要があります。

• SNMPv2c/SNMPv1 クレデンシャルを入力します。

• SNMPv3 クレデンシャルを入力します。

• HTTP クレデンシャルを入力します（Cisco Unified Communications Manager にのみ必須）。

• Windows クレデンシャルを入力します（Windows ベースの MCS アプリケーション サーバにのみ

必須）。
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ステップ 3 [OK] をクリックします。

Operations Manager の物理ディスカバリの設定

Operations Manager の物理検出を設定する手順は次のとおりです。

ステップ 1 [Devices] > [Device Management] > [Auto-Discovery Configuration] を選択します。

[Auto-Discovery Configuration] ページが表示されます。

[Discovery Configuration] ページは、[Device Management: Summary] ページで [Configure] ボタンを

クリックして表示することもできます。

検出には、SNMP または SNMPv3（またはその両方）のクレデンシャルが必要です。

クレデンシャルが設定されていない場合、[Discovery Configuration] をクリックすると、空の 
[Discovery Configuration] ページが表示され、クレデンシャルを設定するオプションが示されます。

a. [Credentials] オプション ボタンを選択します。

b. [Add] をクリックします。

[Configure Credentials] ページが表示されます（「クレデンシャルの設定」（P.2-9）を参照）。

[Discovery] オプション ボタンが選択されていない場合は、それを選択します。

ステップ 2 次のどちらかを実行します。

• [Use Communications Manager or Cisco Discovery Protocol (CDP)] チェックボックスをオンにし、

次のいずれかを実行します。

– カンマ区切りの IP アドレスのリストを使用して、シード デバイスを入力します。

Cisco Unified Communications Manager をシード デバイスとして使用している場合は、次の
タイプのデバイスが検出されます。

- ネットワーク内の他の Cisco Unified Communications Managers

- Cisco Unity 

- MGCP 音声ゲートウェイ

- H.323 音声ゲートウェイ 

- ゲートキーパー 

Cisco Unified Communications Manager ベースの検出に加えて、次のタイプの検出が行われま
す。その結果、デバイスがインベントリに追加されます。

- CDP ベースの検出

- ARP ベースの検出

- ルート テーブル ベースの検出

– [Use devices currently in the system] チェックボックスを選択します。

– ホップ カウントを選択します。

ディスカバリは、選択したホップ カウントより多くのホップをスキップする場合があります。
ディスカバリは複数の技術を使用してデバイスを検出します。その結果、デバイスが L2 ホップま
たは L3 ホップに違反する場合があります。

ディスカバリを制限するためにホップ カウントを使用する場合は、別の方法でその目的を実現で
きます。それは、[Discovery Configuration] ページの Include フィルタおよび Exclude フィルタを
使用する方法です（「Operations Manager の物理ディスカバリのフィルタリング」（P.2-10）を参照
してください）。
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または

• [Use ping sweep] チェックボックスを選択します。シード デバイス オプションと ping スイープ オ
プションは、どちらか一方しか使用できません。

[Use Ping Sweep] チェックボックスをオンにするときは、/netmask 指定を使用して、IP アドレス

範囲をカンマで区切って指定します。

たとえば、172.20.57.1 から始まり、172.20.57.255 で終わる ping スイープ範囲を指定する場合は、

172.20.57.1/24 を使用します。

ステップ 3 [Run] ペインで、いつ物理ディスカバリを実行するかを設定します。

• 物理検出をただちに実行する場合は、[now] オプション ボタンを選択します。

• 物理検出を一定の間隔で実行するようにスケジュールする場合、次のいずれかの手順に従います。

– [Daily] オプション ボタンを選択します。物理検出を実行する時刻を入力し、日付を選択しま

す。

– [every] オプション ボタンを選択します。物理検出を実行する頻度を選択し、実行する間隔を

入力し、実行する曜日を選択します。

ステップ 4 [OK] をクリックします。

クレデンシャルの設定 

検出には、SNMP または SNMPv3（またはその両方）のクレデンシャルが必要です。クレデンシャル

が設定されていない場合は、検出を設定しようとしても [Configure Credentials] ページにしかアクセス

できません。検出を実行する前に、SNMP または SNMPv3（またはその両方）のクレデンシャルを入

力する必要があります。

ステップ 1 [Devices] > [Device Management] > [Auto-Discovery Configuration] > [Credentials] を選択します。

[Configure Credentials] ページが表示されます。

ステップ 2 [Add] をクリックします。

デバイスの既存のクレデンシャルを変更する場合は、宛先デバイスを選択して [Edit] をクリックしま

す。この [Edit] オプションを使用すると、クレデンシャルのみを変更できます。宛先デバイスを変更す

るには、行全体を削除して、詳細をすべて追加し直す必要があります。

ステップ 3 次を入力します。

• IP アドレスまたはホスト名。カンマ区切りのリストを使用して、複数のデバイスを同時に入力で

きます。

複数のデバイスを同時に追加する場合は、すべてのデバイスが同じタイプのデバイスで、同じクレ
デンシャルを使用している必要があります。ワイルドカード エントリを使用する場合は、*.*.*.* 
または 10.76.93.[39-43] という形式のみがサポートされています。

• （任意）SNMP のタイムアウトと再試行を変更します。

• SNMPv2c/SNMPv1 クレデンシャル

• SNMPv3 クレデンシャル

• HTTP クレデンシャル（Cisco Unified Communications Manager に必須）

• Windows クレデンシャル（Windows ベースの MCS アプリケーション サーバに必須）
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ステップ 4 [OK] をクリックします。

Operations Manager の物理ディスカバリのフィルタリング

デバイスをフィルタリングするように Prime UOM 物理検出を設定できます。これはオプションであ

り、物理検出を実行するのに必須ではありません。

ステップ 1 [Devices] > [Device Management] > [Auto-Discovery Configuration] > [Filters and Schedule] を選択し

ます。

[Filters and Schedule] ページが表示されます。

ステップ 2 [Filters] オプション ボタンを選択します。表 2-2 では、物理検出を実行するときに使用できるオプショ

ンのフィルタについて説明します。

表 2-2 物理検出のフィルタ

フィルタ 説明

IP Address （任意）次の操作の対象となるデバイスの IP アドレスまたは IP アドレス範囲を、カン

マで区切って入力します。

• Include：自動検出プロセスに含めます。

• Exclude：自動検出プロセスから除外します。

IP アドレスの範囲を指定する場合は、ワイルドカードを使用できます。

アスタリスク（*）は、1 ～ 255 のオクテット範囲を表します。また、[xxx-yyy] の表

記によってオクテット範囲を制限することもできます。

たとえば、次のように入力します。

• 172.20.57/24 のサブネット内にあるすべてのデバイスを自動検出プロセスに含め

るには、172.20.57.* という組み込みフィルタを入力します。

• 172.20.57.224 ～ 172.20.57.255 の IP アドレス範囲内にあるデバイスを自動検出

プロセスから除外する場合は、172.20.57.[224-255] という除外フィルタを入力し

ます。

172.20.[55-57]* のように、同じ範囲指定の中で両方のタイプのワイルドカードを使用

することもできます。組み込みフィルタと除外フィルタの両方が指定されている場合

は、まず除外フィルタが適用されてから組み込みフィルタが適用されます。

自動検出のデバイスに一度フィルタが適用されると、そのデバイスには他のフィルタ

基準は適用されません。デバイスに複数の IP アドレスがある場合は、組み込みフィル

タの条件を満たす IP アドレスが 1 つでもあれば、そのデバイスは自動検出で処理され

ます。
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ステップ 3 [Apply] をクリックします。

DCR へのデバイスのインポート

バルク インポート（NMS またはファイルから）の場合、Prime UOM では DCR へのダイレクト リン

クが用意されています（[Device Management] > [Device Configuration] > [Import Devices]）。  

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [Import Devices] を選択します。

[Common Services Import Devices] ページが表示されます。

ステップ 2 インポート情報を入力します。

インポートのヘルプが必要な場合は、ページの [Help] ボタンをクリックし、CiscoWorks オンライン 
ヘルプを開きます。

Domain （任意）次の操作の対象となるデバイスのドメイン名を、カンマで区切って入力しま

す。

• Include：自動検出プロセスに含めます。

• Exclude：自動検出プロセスから除外します。

名前はワイルドカードを使用して指定できます。アスタリスク（*）は、大文字と小

文字が混ざった英数字、ハイフン（-）、およびアンダースコア（_）の任意の長さの任

意の組み合わせに一致します。

疑問符（?）は、1 つの大文字または小文字の英数字、ハイフン、またはアンダースコ

アに一致します。たとえば、次のように入力します。

• *.cisco.com は、.cisco.com で終わる任意の名前に一致します。

• *.?abc.com は、.aabc.com や .babc.com などで終わるすべての名前に一致します。

SysLocation （任意）次の操作の対象となるデバイスの MIB-II の sysLocation OID に格納された文

字列値に一致する文字列を、カンマで区切って入力します。

• Include：自動検出プロセスに含めます。

• Exclude：自動検出プロセスから除外します。

場所の文字列はワイルドカードを使用して指定できます。アスタリスク（*）は、大

文字と小文字が混ざった英数字、ハイフン（-）、アンダースコア（_）、および空白

（スペースとタブ）の任意の長さの任意の組み合わせに一致します。

疑問符（?）のワイルドカードは、上記の任意の文字の 1 回の出現に一致します。たと

えば、San * という SysLocation フィルタは、San Francisco や San Jose などで始ま

るすべての SysLocation 文字列に一致します。

表 2-2 物理検出のフィルタ （続き）

フィルタ 説明
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Operations Manager の自動デバイス選択の設定

Prime UOM は、デフォルトで自動的な同期化を使用します。手動の同期化を自動的な同期化に変更す

るには、次の手順を実行します。

同期化プロセスを初めて実行する場合は、Prime UOM に追加されるデバイスの数によっては、Prime 
UOM がすべてのデバイスのインベントリを収集する際に数時間かかる場合があります。

（注） 事前にデバイスが DCR に存在していないと、デバイスを Prime UOM に追加することはできません。

自動デバイス選択を設定する手順は次のとおりです。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [DCR Device Selection] を選択し

ます。

[Device Selection] ページが表示されます。

ステップ 2 [Automatic] オプション ボタンをアクティブにします。

ステップ 3 [Apply] をクリックします。

Prime UOM が DCR と同期されます。現在 Prime UOM にない DCR デバイスが追加されます。Prime 
UOM は、追加する新しいデバイスに関してインベントリ収集を実行します。

ステップ 4 [Administration] > [Device Management] > [Device Configuration] > [IP Address Report] を選択して、

重複デバイスがないかどうかを確認します。

この重複デバイスが導入環境に必要ない場合は削除します（デバイスの削除方法については、「デバイ

スの削除」（P.8-60）を参照してください）。

DCR から Operations Manager への手動によるデバイスの追加

Prime UOM を自動デバイス選択に設定した場合は、この手順を実行する必要はありません。手動デバ

イス選択では、モニタするデバイスを手動で選択する必要があります。デバイスが DCR に追加された

後に、定期的にこの作業を実行する必要があります。

たとえば、週単位で Operations Manager の物理ディスカバリを実行する場合は、ディスカバリが終了

するたびにモニタする新しいデバイスを確認するかどうかを検討する必要があります。

（注） 事前にデバイスが DCR に存在していないと、デバイスを Prime UOM に追加することはできません。

デバイスを手動で追加するには、次の手順を実行します。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [DCR Device Selection] を選択し

ます。

[Device Selection] ページが表示されます。

ステップ 2 [Manual] オプション ボタンを選択します。

Prime UOM インベントリに存在しないすべてのデバイスがデバイス セレクタに表示されます。
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ステップ 3 次の方法でデバイスを選択します。

• [Device Display Name] にデバイス名または IP アドレスを入力して、[Filter] をクリックする。

• グループ セレクタを使用する。

選択したデバイスを確認する場合は、[Selection] タブをクリックすると、デバイスのリストが表示さ

れます。

ステップ 4 [Select] をクリックします。

Operations Manager は、追加されているデバイスに関してインベントリ収集を実行します。

ステップ 5 [Administration] > [Device Management] > [Device Configuration] > [IP Address Report] を選択して、

重複デバイスがないかどうかを確認します。

この重複デバイスが導入環境に必要ない場合は削除します（デバイスの削除方法については、「デバイ

スの削除」（P.8-60）を参照してください）。

デバイスの状態について

[Device Management: Summary] ページには、Prime UOM インベントリのすべてのデバイスの状態が

表示されます。このページを表示するには、[Administration] > [Device Management] > [Device 
Configuration] > [Device Summary] を選択します。

電話機検出収集のステータスを表示するには、「電話 XML 検出ステータスの確認とスケジュール」

（P.8-67）を参照してください。

表 8-3 に、[Device Management Summary] ページに表示される情報を示します。

表 2-3 では、インベントリにデバイスを追加したときのデバイスの状態遷移について説明します。

表 2-3 インベントリに追加されたときのデバイスの状態遷移

インベントリ収集の開始 インベントリ収集の結果 結果のデバイス状態

インベントリ収集が進行中であ

る。

正常に検出された。 Monitored

インベントリ収集が進行中であ

る。

すべてのクレデンシャルが入力さ

れていないか、または、一部の

サービスが停止している。

Partially Monitored

インベントリ収集が進行中であ

る。

• SNMP 情報が設定されていな

い。

• デバイスが応答していない。

• デバイスは到達不能である。

• デバイス クレデンシャルが正

しくない。

Unreachable

インベントリ収集が進行中であ

る。

• デバイス モデルが認識されな

い。

• ソフトウェア バージョンがサ

ポートされていない。

Unsupported
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Prime UOM に追加したデバイスの確認

Device Summary で Monitored 状態にあるかどうかを調べることで、デバイスが Prime UOM インベン

トリに追加されていることを確認できます。  デバイスを確認するには、次の手順を実行します。

ステップ 1 [Administration] > [Device Management] > [Device Summary] を選択します。

ステップ 2 デバイスを探して Monitored 状態にあるかどうかを確認します。

インベントリ収集中に問題が発生した場合は、「デバイス インポートおよびインベントリ収集のトラブ

ルシューティング」（P.2-15）を参照してください。

インベントリ収集のスケジュール

デバイスと電話には、個別のインベントリ収集スケジュールがあります。デバイス用のインベントリ収

集スケジュールは 1 つだけです。スケジュールをさらに作成することはできません。既存のスケジュー

ルの変更のみ行うことができます。IP フォンの場合は、複数のインベントリ収集スケジュールを作成

できます。

Inventory Collection Schedule ページ（[Administration] > [Device Management] > [Inventory 
Collection] > [Device]）では、デバイス インベントリ収集スケジュールを編集、一時停止、または再

開することができます （「デバイスのインベントリ収集スケジュールの編集」（P.2-14） を参照）。

[IP Phone Discovery Schedule] ページ（[Devices] > [Device Management] > [Inventory Collection] > 
[IP Phone]）では、IP Phone ディスカバリ スケジュールを追加、編集、または削除することができま

す （「電話機検出スケジュールの追加」（P.2-15） を参照）。

デバイスのインベントリ収集スケジュールの編集

デバイスのインベントリ収集スケジュールを編集する手順は次のとおりです。

ステップ 1 [Administration] > [Device Management] > [Inventory Collection] > [Device] を選択します。

[Device Inventory Collection] ページが表示されます。

ステップ 2 [Edit] をクリックします。

[Inventory Collection Schedule: Edit] ページが表示されます。

ステップ 3 目的のスケジュール情報を変更します。

ステップ 4 [OK] をクリックします。

ステップ 5 [Yes] をクリックします。
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電話機検出スケジュールの追加

電話機検出スケジュールを追加するには、次の手順を実行します。

ステップ 1 [Devices] > [Device Management] > [Inventory Collection] > [IP Phone Details] を選択します。

[IP Phone Discovery Schedule] ページが表示されます。

ステップ 2 [Add] をクリックします。

[Add Schedule] ダイアログボックスが表示されます。

ステップ 3 次を入力します。

• 検出スケジュールの名前

• 検出を実行する曜日 

• 検出を実行する時刻

ステップ 4 [OK] をクリックします。

デバイス インポートおよびインベントリ収集のトラブルシューティング 
デバイスのインベントリ収集をトラブルシューティングするには、次のことを試してください。

• デバイスが応答していない場合は、すべてのデバイス クレデンシャルを確認し、デバイスを再度

追加します。「デバイスの設定とクレデンシャルの編集」（P.2-16）を参照してください。 

• デバイスのインベントリ収集が複数のデバイスでタイムアウトする場合は、SNMP タイムアウト

の設定値を大きい値にします。「SNMP タイムアウトと再試行の変更」（P.2-16）を参照してくださ

い。 

• [Modify/Delete Device] ページのデバイス エラー情報を表示します。「デバイスのインベントリ収

集の手動実行」（P.2-17）を参照してください。 

• デバイスがインポート中に動作可能な状態で、MIB II をサポートしていることを確認します。

• デバイスが DNS で解決可能であることを確認します。「Cisco Unified Communications のデバイ

スの DNS 設定」（P.2-37）を参照してください。

• 到達不能状態になっているデバイスの原因をチェックします。「Prime UOM をはじめる前に」

（P.2-21）を参照してください。

• 問題をトラブルシューティングしたら、デバイスのステータスを確認します。「Prime UOM に追加

したデバイスの確認」（P.2-14）を参照してください。

[Modify/Delete Devices] ページには、デバイス情報とデータ収集情報が表示されます。

[Modify/Delete Devices] ページを使用して、デバイスの現在の状態を判別したり、データ収集エラー

を表示したりできます。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [Modify/Delete Devices] を選択

します。

[Modify/Delete Devices] ページが開きます。

ステップ 2 デバイスのインベントリ収集ステータスに応じて、目的のデバイスがあるフォルダを展開します

（「Prime UOM に追加したデバイスの確認」（P.2-14）を参照してください）。

ステップ 3 デバイス名または IP アドレスをクリックします。
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デバイス情報が表示されます。

ステップ 4 [Data Collection Status Information] にエラー情報がないか確認します（「Prime UOM をはじめる前に」

（P.2-21）を参照してください）。

ステップ 5 エラーをクリアするために必要なアクションを実行します。

部分的に監視されるデバイスに発生し、[Modify/Delete Devices] ページに表示されるエラー コードの

考えられる原因を説明する 表 8-9 も参照してください。

デバイスの設定とクレデンシャルの編集

デバイスを追加した後は、以下のように設定を変更することができます。デバイス設定とクレデンシャ

ルを編集するには、次の手順に従います。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [Device Credentials] を選択しま

す。

Common Services の [Device Summary] ページが開きます。

ステップ 2 デバイスが含まれているフォルダを展開します。

ステップ 3 更新するデバイスまたはデバイス グループを選択します。

ステップ 4 [Edit Credentials] をクリックします。

[Edit Device Configuration: Change Credentials] ページが表示されます。

• 単一デバイスを選択した場合は、そのデバイスに対して既存のすべてのクレデンシャルが [Edit 
Device Configuration: Change Credentials] ページで設定されます（アスタリスクがフィールドに

設定される）。

• 複数のデバイスを選択した場合は、カンマ区切りの IP アドレスのリストのみが表示されます。

自動的に設定されるクレデンシャル（アスタリスク）は、実際のクレデンシャルを反映していませ
ん。これらは、クレデンシャルが使用可能であることを示しているにすぎません。

ステップ 5 次のクレデンシャルを更新できます。

• SNMPv2c/SNMPv1

• SNMPv3

• HTTP

• WMI

重複したデバイスの一方のクレデンシャルを変更する場合は、プライマリ デバイスが削除された場合

のために、必ず両方のデバイスのクレデンシャルを変更してください。

ステップ 6 [OK] をクリックします。

SNMP タイムアウトと再試行の変更

SNMP クエリーが時間内に応答しない場合、Prime UOM がタイムアウトします。Prime UOM は、

ユーザが指定した回数だけデバイスへのアクセスを再試行します。リトライ回数を重ねるごとにタイム

アウト期間が倍になります。
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たとえば、タイムアウト値が 4 秒で、再試行値が 3 秒の場合、Prime UOM は、4 秒間待ってから 1 回
目の再試行を実行し、次に 8 秒間待ってから 2 回目の再試行を実行し、さらに 16 秒間待ってから 3 回
目の再試行を実行します。

SNMP のタイムアウトと再試行値は、グローバル設定です。次のように値を変更します。

ステップ 1 [Devices] > [Device Management] > [Inventory Collection] > [SNMP Configuration] を選択します。

[SNMP Configuration] ページが表示されます。

ステップ 2 新しい SNMP のタイムアウト設定を選択します。デフォルトは 4 秒です。

ステップ 3 新しいリトライ回数の設定を選択します。デフォルトの試行回数は 3 回です。

ステップ 4 [Apply] をクリックします。

ステップ 5 確認のために [Yes] をクリックします。

デバイスのインベントリ収集の手動実行

[Modify/Delete Devices] ページを使用して、デバイスまたはデバイス グループのインベントリ収集を

手動で実行することができます。インベントリ収集が発生すると、デバイスまたはグループの設定に変

更があった場合は、新しい設定によって以前のすべての設定が上書きされます。

（注） Prime UOM でデバイスの設定変更が検出されるのは、デバイスの検出（インベントリ収集）が実行さ

れている間だけです。したがって、デバイスの設定への変更は、設定を変更した後に次回インベントリ

収集が実行されるまで Prime UOM では表示されません。

インベントリ収集は、アクティブなデバイスに対してのみ実行されます。一時停止されたデバイスは、

インベントリ収集の対象にはなりません。インベントリ収集の対象として選択したデバイスの一部が一

時停止中の場合は、Prime UOM にアクティブなデバイスだけがインベントリ収集の対象になるという

メッセージが表示されます。

Prime UOM 物理検出プロセス（デバイスを DCR に追加するプロセス）や Prime UOM インベントリ

収集プロセス（デバイスを調査して Prime UOM インベントリのコンポーネントをアップデートするプ

ロセス）を、DCR 同期化プロセスと混同しないでください。Prime UOM インベントリ収集は、Prime 
UOMインベントリだけに影響するプロセスです。

次のイベントが発生したときもインベントリ収集が実行されます。

• Prime UOM インベントリ全体がポーリングされる。このイベントは、インベントリ収集スケ

ジュールによって制御されます （「インベントリ収集のスケジュール」（P.2-14） を参照）。

• Prime UOM が DCR との自動的な同期化を使用している場合に、DCR にデバイスが追加される

か、DCR 内のデバイスが変更される。このような DCR の変更には、デバイスの削除や、デバイ

スのクレデンシャル（IP アドレス、SNMP クレデンシャル、MDF タイプ）の変更なども含まれま

す。

• Prime UOM が DCR との手動の同期化を使用している場合に、[Device Selection] ページを使用し

て Prime UOM にデバイスが追加される。

ACS ログイン モジュールを使用している場合、ACS に設定されているシステム ID ユーザは Common 
Services のすべてのジョブ管理関連タスクと Prime UOM の再検出タスクを実行する権限を持っている

必要があります。
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再検出が実行されると、システム内のすべてのデバイスが検出されます。そのため、このタスクはネッ

トワーク内のすべてのデバイスにアクセスできるユーザのみが使用できるようにする必要があります。

ステップ 1 [Administration] > [Device Management] > [Device Configuration] > [Modify/Delete Devices] を選択

します。

[Modify/Delete Devices] ページが表示されます。

ステップ 2 インベントリ収集を実行するデバイスまたはグループを選択します。

ステップ 3 [Rediscover] をクリックします。

インベントリ収集が開始されます。

デバイス収集前のデバイスの設定
この項では、次の項目の概要について説明します。

• 「音声アプリケーション システムおよびソフトウェアの使用」（P.2-27）

• 「Prime UOM に syslog レシーバを [Send Events] に設定」（P.2-30）

Prime UOM へのデバイスの追加
ここでは、デバイス検出およびインベントリ収集の手順の概要について説明します。

デバイスを Prime UOM に追加する多くのオプションがあります。使用している導入によっては、

表 2-4 でオプションを使用してデバイスを追加できます。

表 2-4 Prime UOM インベントリへのデバイスの追加  

展開タイプ インベントリ収集オプション 説明

エンタープライズ 
ユーザのみ

1. 自動的にデバイスを検出します。1 • デフォルト設定を使用します（エンタープラ

イズ バージョンでは操作不要）。詳細につい

ては、「エンタープライズ導入のデバイスを

自動的に検出」（P.8-3）を参照してくださ

い。

• 自動検出のための設定を行います。「DCR か
らの特定のデバイスの追加」（P.8-8）を参照

してください。 

• 自動デバイス検出のビデオ チュートリアル

を見るには、オンライン ヘルプの 
[E-Learning] アイコンをクリックします。
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エンタープライズま

たはマルチ エンド 
カスタマー バージョ

ン

2. デバイスを手動で追加します。

（エンタープライズ バージョンまたはマルチ エン

ドカスタマー バージョンのみ）

「DCR へのデバイスの追加」（P.8-8）

エンタープライズま

たはマルチ エンド 
カスタマー バージョ

ン

3. デバイスをインポートします。

（エンタープライズ バージョンまたはマルチ エン

ドカスタマー バージョンのみ）

「DCR へのデバイスのインポート」（P.2-11）

1. インベントリ情報を収集するには、デバイス クレデンシャルが必要です。エンタープライズ バージョンの場合、自動検出がデフォルトで

す。マルチ エンドカスタマー バージョンを導入した場合に検出を処理する方法の詳細については、「DCR へのデバイスの追加」（P.8-8）
または「DCR へのデバイスのインポート」（P.2-11）を参照してください。

表 2-4 Prime UOM インベントリへのデバイスの追加 （続き） 

展開タイプ インベントリ収集オプション 説明
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Prime UOM のカスタマイズ
この項では、必須ではないものの、Prime UOM の機能を拡張する操作について説明します。

• 「サポートされる NMS 統合」（P.2-23）

• 「イベントの表示」（P.2-37）

デバイスを追加した後、Prime UOM はネットワークをモニタしています。表 2-5 に、特定の構成に応

じてPrime UOM をカスタマイズするために実行することのある作業を示します。

（注） これらの作業はすべてオプションです。Prime UOM がネットワークをモニタするための必須の作業で

はありません。

表 2-5 Prime UOM のセットアップ

作業 説明

通知の設定 Unified Dashboard 画面を監視してイベントを確認するほか、

イベントに応じて、ユーザが電子メールを受信したり、ホス

トが Prime UOM によって生成された SNMP トラップを受信

したりするように登録できます。

デバイス グループの設定 [Fault Monitor] 画面や、通知サービスの通知グループで使用

するデバイス グループを作成します。

ポーリング パラメータとしきい値の設

定

Prime UOM には、ポーリング パラメータとしきい値のデ

フォルト値があります。ただし、ネットワークの必要に応じ

て、値をアップデートできます。

Prime UOM サーバのアクティビティが低い場合は、変更の

適用を計画する必要があります。

デフォルトでは、Prime UOM は音声使用率のポーリング設

定値を設定しません。Prime UOM のパフォーマンス モニタ

リング機能を使用する場合は、最初に音声使用率のポーリン

グをイネーブルにする必要があります。

消去の設定 デフォルトでは、Prime UOM は毎日午前 0 時にデータベー

スを消去します。このスケジュールは変更できます。

インベントリ収集の設定 エンタープライズ バージョンの場合のみ、Prime UOM で
は、インベントリ収集用に単一のデフォルト スケジュールを

提供します。そのスケジュールを使用することもできれば、

一時停止することもできます。
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Prime UOM をさらに活用するために、デバイス、レポート、その他の機能に特有の設定手順がありま

す。詳細については、「デバイス収集前のデバイスの設定」（P.2-18）を参照してください。

Prime UOM をはじめる前に

Prime UOM は Prime UOM サーバまたはクライアント システムからアクセスできます。

• クライアント システムが使用可能な場合は、すべての設定と日常的なアクティビティをクライア

ント システムから実行することを推奨します。クライアント システムが使用できない場合は、

Prime UOM サーバでもクライアント システムのすべてのシステム要件を満たしている必要があり

ます。クライアント システムの要件については『Installation Guide for Cisco Prime Unified 
Operations Manager』を参照してください。

• クライアント システムにインストールされているすべてのポップアップ ブロッカー ユーティリ

ティをディセーブルにしてから、Prime UOM を起動します。

• デフォルトでは、SSL は Common Services でイネーブルにされていません。Prime UOM 9.0 に
アップグレードし、SSL をイネーブルにしてからアップグレードした場合、アップグレード後もイ

ネーブルのままです。

クライアント システムでの Prime UOM の起動 
Internet Explorer で、Prime UOM サーバの IP アドレスまたは名前に続けてポート番号 1741 を入力し

ます。たとえば、http://om_server name:1741 と入力します。

Prime UOM サーバでの Prime UOM の起動 
Windows デスクトップで、[Start] > [All Programs] > [Cisco Unified Operations Manager] > [Cisco 
Unified Operations Manager] を選択します。

（注） 拡張セキュリティが Windows 2003 または Windows 2008 システムでイネーブルになっている場合は、

Internet Explorer の信頼済みサイト ゾーンに Prime UOM ホーム ページを追加する必要があります。信

頼済みサイトに追加するまでは、Prime UOM ホーム ページにアクセスできません。

Diagnostics View のカスタマイズ Diagnostic Summary、Server、Phone、Gateway、Cluster の
各 View に表示するビューのポートレットを変更できます。

特定のデバイス イベントのアクティブ

化

デバイスが Prime UOM データベースに追加されると、ほと

んどのデバイス イベントがユーザ インターフェイスに表示

されます。

ただし、いくつかのイベントは、Prime UOM で設定しなけ

れば表示されません。

次のイベントを Prime UOM で表示するには、それをアク

ティブ化する必要があります。

• HardwareFailure

• Number Of Registered Gateways Increased

• Number Of Registered Gateways Decreased

• Number Of Registered MediaDevices Increased

• Number Of Registered MediaDevices Decreased

表 2-5 Prime UOM のセットアップ （続き）

作業 説明
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Internet Explorer 信頼済みサイト ゾーンへの Operations Manager ホー
ムページの追加

拡張セキュリティが Windows 2003 または Windows 2008 システムでイネーブルになっている場合、

Prime UOM ホーム ページにアクセスする前に、次の手順を実行する必要があります。

Operations Manager ホーム ページを追加する手順は次のとおりです。

ステップ 1 Prime UOM を開き、[Start] > [All Programs] > [Cisco Unified Operations Manager] > [Cisco Unified 
Operations Manager] を選択します。

ステップ 2 [File] メニューから [Add this site to] を選択します。

ステップ 3 [Trusted Sites Zone] をクリックします。

ステップ 4 [Trusted Sites] ダイアログボックスで、[Add] をクリックしてこのサイトをリストに移します。

ステップ 5 [Close] をクリックします。

ステップ 6 ページをリフレッシュして新しいゾーンからこのサイトを表示します。

ステップ 7 ブラウザのステータス バーをチェックして、サイトが信頼済みサイト ゾーンにあることを確認します。

Prime UOM からの Cisco Unified Communications Management 
Server リンクの追加

ローカルにインストールされたか、またはリモートにインストールされた Service Monitor、Service 
Statistics Manager、または Provisioning Manager サーバへのリンクを Prime UOM から追加するには、

[UC Management Suite] タブを使用します。

ステップバイステップの説明については、「Cisco Unified Communications 管理アプリケーション リン

クの設定」（P.21-1） を参照してください。

Service Monitor のイベントやトラップの処理についての詳細は、「処理される SNMP トラップ」

（P.C-1） を参照してください。未解決の問題については、『Release Notes for Cisco Prime Unified 
Operations Manager』を参照してください。

セキュリティの概要と設定について

Prime UOM は、次のセキュリティ関連のメカニズムをサポートしています。

• SNMPv3 プロトコル（認証 /非プライバシー オプション）：Prime UOM は、サーバとデバイス間

で認証 /非プライバシー オプションをサポートしています。

• Local security or Cisco Secure ACS：Prime UOM 内のタスクへのアクセスは、ローカル セキュリ

ティ（Common Services Local Login Module）または Cisco Security ACS によって制御されます。

デフォルトで、サーバ上のローカル セキュリティはイネーブルです。

Prime UOM は Cisco Secure ACS との統合をサポートします。詳細については、『Installation 
Guide for Cisco Prime Unified Operations Manager』の「Security Configuration with 
Cisco Secure ACS」（p. C-1）を参照してください。
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• SSL：Secure Socket Layer（SSL）は、プライバシー、認証、およびデータ整合性を通じて、デー

タの安全なトランザクションを実現するアプリケーション レベルのプロトコルです。SSL では、

証明書、公開キー、および秘密キーを使用します。（デフォルトでは、SSL は Common Services で
イネーブルになっていません）。

セキュアなアクセスの必要性に応じて、SSL をイネーブルまたはディセーブルにすることができま

す。Prime UOM は、クライアントとサーバの間の SSL をサポートしています。

セキュリティの設定を開始するには、Common Services のヘルプの「Setting Up Security」のトピック

を参照してください。

サポートされる NMS 統合

Prime UOM は、使用しているネットワークに存在するネットワーク管理システム（NMS）との統合を

サポートします。Prime UOM は Prime UOM と同じシステムに混在する NMS をサポートしません。

• Prime UOM は、ポート 162（デフォルト）で管理対象デバイスからのトラップを受信します。

ネットワーク デバイスがすでにトラップを別の管理アプリケーションに送信している場合は、ト

ラップを Prime UOM に転送するようそのアプリケーションを設定してください。

• Prime UOM は、次のように、ユーザが指定した宛先にトラップを転送します。

– パススルー トラップを転送するには、「SNMP トラップの受信とフォワーディングの設定」

（P.2-23）を参照してください。

– 処理されたトラップを転送するには、「通知の設定」（P.15-7） を参照してください。

パススルー、および処理されたトラップの詳細については、「処理される SNMP トラップ」

（P.C-1） を参照してください。

SNMP トラップの受信とフォワーディングの設定

Prime UOM は、使用可能な任意のポートでトラップを受信し、そのトラップをデバイスおよびポート

のリストに転送できます。この機能により、Prime UOM は、他のトラップ処理アプリケーションと簡

単に連携できます。

ただし、デバイスの SNMP をイネーブルにして、Prime UOM または次のいずれかに直接トラップを送

信するように SNMP を設定する必要があります。

• 1 つの NMS

• 1 つのトラップ デーモン

この項の構成は、次のとおりです。

• 「SNMP トラップ受信ポートの更新」（P.2-24）

• 「Prime UOM にトラップを送信するためのデバイスの設定」（P.2-24）

• NMS またはトラップ デーモンへの Prime UOM トラップ受信の統合

• 「SNMP トラップ転送の設定」（P.2-25）

• 「SNMP トラップとして Windows イベントを転送」（P.20-7）

トラップを直接 Prime UOM に送信するには、「Prime UOM にトラップを送信できるようにするための

デバイスの設定」（P.20-6）の作業を実行します。

SNMP トラップの受信を NMS またはトラップ デーモンと統合するには、「NMS またはトラップ デー

モンへの Prime UOM トラップ受信の統合」（P.2-24）の手順に従います。
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SNMP トラップ受信ポートの更新

デフォルトで、Prime UOM はポート 162 で SNMP トラップを受信します。このポートは、必要に応

じて変更することができます。

SNMP トラップ受信ポートを更新する手順は次のとおりです。

ステップ 1 [Administration] > [System Settings] > [Miscellaneous] > [Preferences] を選択します。

[System Preferences] ページが表示されます。

ステップ 2 [Trap] フィールドに、ポート番号を入力します。

ステップ 3 [Apply] をクリックします。

Prime UOM が使用するポートのリストについては、「Prime UOM が監視するポートとインターフェイ

ス」（P.8-6）を参照してください。

Prime UOM にトラップを送信するためのデバイスの設定

Prime UOM は SNMP MIB の変数とトラップを使用してデバイスのヘルスを判別するため、この情報

を提供するようにデバイスを設定する必要があります。Prime UOM の監視対象とするすべてのシスコ 
デバイスで SNMP をイネーブルにし、Prime UOM サーバに SNMP トラップを送信するようそのデバ

イスを設定する必要があります。

デバイスに適切なコマンドライン インターフェイスまたは GUI インターフェイスを使用して、デバイ

スが Prime UOM にトラップを送信できるようにします。「Prime UOM にトラップを送信できるように

するためのデバイスの設定」（P.20-6）を参照してください。 

（注） Prime UOM によって管理されるパブリックおよびプライベート両方の IP インターフェイスがあるデバ

イスに対するマルチ エンドカスタマー バージョン導入では、トラップ ソースはパブリック IP イン

ターフェイスだけを使用する必要があります。

NMS またはトラップ デーモンへの Prime UOM トラップ受信の統合

SNMP トラップの受信を他のトラップ デーモンおよび他のネットワーク管理システム（NMS）と統合

するには、次の作業を 1 つ以上完了する必要がある場合があります。

• Prime UOM を実行しているホストを、ネットワーク デバイスのトラップ宛先リストに追加しま

す。「Prime UOM にトラップを送信するためのデバイスの設定」（P.2-24）を参照してください。  
宛先トラップ ポートとしてポート 162 を指定します。

• ネットワーク デバイスがすでにトラップを別の管理アプリケーションに送信している場合は、ト

ラップを Prime UOM に転送するようそのアプリケーションを設定します。

表 2-6 は、SNMP トラップ受信のシナリオを示し、それぞれの利点を挙げています。
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SNMP トラップ転送の設定

デフォルトでは、Prime UOM は未処理の SNMP トラップを転送しません。ただし、転送するように設

定することはできます。

トラップ転送を設定するには、次の手順を実行します。

ステップ 1 [Administration] > [System Settings] > [Miscellaneous] > [Preferences] を選択します。

[System Preferences] ページが表示されます。

ステップ 2 [Trap Forwarding Parameters] に、次の情報を入力します。

• サーバの IP アドレスまたは名前。

• トラップの受信が可能なサーバのポート番号 

他の Cisco Unified Communications Manager アプリケーションが使用するポートのリストについ

ては、「Prime UOM および他の CUCM アプリケーションが使用するポートとプロトコル」

（P.20-9） を参照してください。

ステップ 3 [Apply] ボタンをクリックします。

Health Monitor の設定 
Health Monitor ユーティリティは、Operations Manager プロセスをモニタし、プロセスが停止して再

起動したときに気づき、電子メールの更新を送信できます。

電子メールの更新を受信するには、次の手順を実行します。

ステップ 1 NMSROOT/HealthMonitor/conf/HealthMonitor.cfg ファイルを編集します。

ステップ 2 次の各パラメータ値を入力します。

表 2-6 トラップ受信の設定シナリオ

シナリオ 利点

ネットワーク デバイスが、Prime 
UOM を実行しているホストの

ポート 162 にトラップを送信す

る。

Prime UOM はトラップを受信し、

そのトラップを NMS に転送しま

す。

• NMS の再設定が不要。

• ネットワーク デバイスの再設定が不要。

• Prime UOM が信頼性の高いトラップ受信、ストレージ、お

よびフォワーディング メカニズムを提供。

• NMS は継続して、NMS が実行されているホストのポート 
162 でトラップを受信します。

• ネットワーク デバイスが引き続きポート 162 にトラップを

送信。

NMS がデフォルト ポート 162 で
トラップを受信し、Prime UOM 
を実行しているホストのポート 
162 にそのトラップを転送する。

• NMS の再設定が不要。

• ネットワーク デバイスの再設定が不要。

• Prime UOM は、NMS によってドロップされたトラップを

受信しない。
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• SMTP_Server：SMTP メール サーバのアドレス。

• Receiver_Email_ID：通知先の管理者の電子メール ID

• Sender_Email_ID：送信者を特定する電子メール ID 

ステップ 3 ファイルを更新したら、HealthMonitor サービスを再起動して更新を有効にします。コマンドラインか

ら、次のコマンドを入力します。

net stop HealthMonitor

net start HealthMonitor

詳細については、「通知の設定」（P.15-7）を参照してください。

Internet Explorer 信頼済みサイト ゾーンへの Operations Manager ホー
ムページの追加

拡張セキュリティが Windows 2003 または Windows 2008 システムでイネーブルになっている場合、

Prime UOM ホーム ページにアクセスする前に、次の手順を実行する必要があります。

Operations Manager ホーム ページを追加する手順は次のとおりです。

ステップ 1 Prime UOM を開き、[Start] > [All Programs] > [Cisco Unified Operations Manager] > [Cisco Unified 
Operations Manager] を選択します。

ステップ 2 [File] メニューから [Add this site to] を選択します。

ステップ 3 [Trusted Sites Zone] をクリックします。

ステップ 4 [Trusted Sites] ダイアログボックスで、[Add] をクリックしてこのサイトをリストに移します。

ステップ 5 [Close] をクリックします。

ステップ 6 ページをリフレッシュして新しいゾーンからこのサイトを表示します。

ステップ 7 ブラウザのステータス バーをチェックして、サイトが信頼済みサイト ゾーンにあることを確認します。

Prime UOM サーバの DSCP トラフィックの優先順位付けの設定

Prime UOM サーバで、設定可能な DSCP の優先順位がマークされるパケットをマークできるようにす

るには、次の手順を実行します（Windows 2008 サーバのみ）。

1. Windows の [Start] > [Run] を選択します。

2. gpedit.msc と入力し、[Enter] をクリックして、ローカル グループ ポリシー エディタを開きます。

3. [Local Computer Policy] > [Computer Configuration] > [Windows Settings] > [Policy-based QoS] 
を選択し、ポリシーを作成します。たとえば、dscp_settings と名付けます。

4. [Policy Profile] タブで、このポリシーに対する DSCP 値を指定します。たとえば 55 と入力しま

す。

5. [Application Name] タブで、[All Applications] を選択します。
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6. [IP Addresses] タブで、[This QoS policy applies to Any source IP address and any destination IP 
address] を選択します。

7. [Protocol and Ports] タブで、[this QosS policy applies to TCP and UDP] を選択します。また、送

信元ポートと宛先ポートも選択します。

8. [OK] をクリックします。

9. これらのポリシーの変更を適用するには、次のコマンドを実行する必要があります。gpupdate 
/force 

音声アプリケーション システムおよびソフトウェアの使用
次のトピックでは、ハードウェア固有およびバージョン固有のタスクと動作について説明します。

• 「Prime UOM で使用するための音声アプリケーション システムおよびソフトウェアの設定」

（P.2-28）

• 「Cisco Unified CM のクラスタ名の変更」（P.2-28）

• 「Cisco Unified CM での CDR の転送の設定」（P.2-29）

• 「メディア サーバの SNMP サービス コミュニティ ストリング権限の設定」（P.2-30）

• 「Prime UOM に syslog レシーバを [Send Events] に設定」（P.2-30）

• 「Unity Event Monitoring Service の設定」（P.2-34）

• 「Cisco Unified CM での RTMT の設定」（P.2-36）

• 「Cisco Unified CM での HTTP クレデンシャルの設定」（P.2-37）

• 「Cisco Unified Communications のデバイスの DNS 設定」（P.2-37）

（注） Cisco Unified Communications Manager のバージョンおよびサポートに関する最新の詳細情報は、

Cisco.com の Cisco Unified Communications Manager 互換性マトリクスを参照してください。
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Prime UOM で使用するための音声アプリケーション システムおよびソフ
トウェアの設定

表 2-7 に、Cisco Prime Unified Operations Manager（Prime UOM）が Cisco 音声アプリケーション ソ
フトウェアを正常に監視できるようにするために、事前に実行する必要のあるタスクを示します。

Cisco Unified CM のクラスタ名の変更

（注） この手順を実行する必要があるのは、メディア サーバを Cisco Unified CM 3.3 以降で実行している場

合だけです。

Prime UOM は、同じ名前を持つ 2 つのクラスタは管理できません。複数の Cisco Unified CM クラス

タを管理する場合は、デフォルトのクラスタ名を変更する必要があります。Cisco Unified CM 3.3 以降

では、デフォルトのクラスタ名として StandAloneCluster を使用しています。

表 2-7 アプリケーション ソフトウェアのバージョンおよびシステム別のコンフィギュレーション タス

ク

使用する音声アプリケーショ

ン ソフトウェア ...
使用する音声アプリケー

ション システム ... 実行する必要のあるタスク

Prime UOM がサポートする

任意のアプリケーション ソフ

トウェア

メディア サーバ 「メディア サーバの SNMP サービス コ
ミュニティ ストリング権限の設定」

（P.2-30）

Cisco Unified 
Communications Manager 3.3 
以降

メディア サーバ 「Cisco Unified CM のクラスタ名の変更」

（P.2-28）

Cisco Unified 
Communications Manager 6.x 
以降

メディア サーバ 「Cisco Unified CM での syslog レシーバ

の設定」（P.2-31）

メディア サーバ 「Cisco Unified CM での CDR の転送の設

定」（P.2-29）

Cisco Unified 
Communications Manager 
Express

ルータ ルータの CCMEEnabled を true に設定

します。1.3.6.1.4.1.9.9.439.1.1.1.0 の 
snmp get が 1 を返すように設定します。

SRST ルータ ルータ このルータの SRST サービスをイネーブ

ルにします。1.3.6.1.4.1.9.9.441.1.2.1.0 
の snmp get が 1 を返すように設定しま

す。

Cisco Unity Connection N/A 「Cisco Unity Connection の syslog レシー

バの設定」（P.2-33）

Cisco Unified 
Communications Manager 
5.1.3 以降（Syslog/RTMT の
場合）

音声ゲートウェイ

メディア サーバ 

「Operations Manager でのイベントのアク

ティブ化」（P.E-96）

Cisco Unified Presence N/A 「Cisco Unified Presence の syslog レシー

バの設定」（P.2-34）
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Cisco Unified CM の設定の詳細な説明については、Cisco Unified CM のマニュアルを参照してくださ

い。

Cisco Unified CM クラスタ名を変更するには、次の手順を実行します。

ステップ 1 Cisco Unified CM クラスタ名を変更するには、 [Cisco Unified Communications Manager 
Administration] ページを開きます。

ステップ 2 メニューバーの [System] を選択し、次に [Enterprise Parameters] を選択します。

[Enterprise Configuration] ページが開きます。

ステップ 3 Cluster ID フィールドに、新しいクラスタ名を入力します。

ステップ 4 [Update] をクリックします。

Prime UOM で、すでに追加 /監視されたクラスタのクラスタ ID を変更するには、次の手順を実行しま

す。

ステップ 1 Prime UOM から、クラスタ（すべてのノード）を完全に削除します。

ステップ 2 Cisco Unified CM のクラスタ ID を変更します。この前の手順を参照してください。

ステップ 3 クラスタ ID を変更した場合、Prime UOM にクラスタ全体を再度追加します。

Cisco Unified CM での CDR の転送の設定

Prime UOM を使用して、Unified CM の Call Detail Record（CDR）トランク使用率を監視できます。

Service Monitor を Prime UOM で監視される UC 管理アプリケーションとして追加する必要がありま

す。詳細については、「Service Monitor サーバへのアクセス」（P.21-2） 

また、Prime UOM でポーリングをイネーブルにする必要があります。詳細については、「ポーリング 
パラメータの編集」（P.19-16）

Prime UOM および Service Monitor を使用して CDR ベースのトランク データを監視する手順は次の

とおりです。

ステップ 1 Unified Communications Manager で、[Administration] を選択します。

ステップ 2 [System] > [Service Parameters] を選択して、[Service Parameters Configuration] ページを開きます。

ステップ 3 次のパラメータを設定します。

• [CDR Enabled Flag]：[System] まで下方にスクロールして、[True] を選択します。

• [Cluster wide Parameters]（Device - General）までスクロール ダウンし、[Set to Enable Only 
When CDR Enabled Flag is True] を選択して、[Call Diagnostics Enabled] を設定します。

ステップ 4 Cisco Unified CM で Prime UOM を課金サーバとして追加する手順は次のとおりです。

a. [Tools] > [CDR Management] を選択します。

b. [Billing Applications Server Parameters] までスクロールし、[Add New] をクリックします。

c. 次を入力します。
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– [Host Name]/[IP Address]：Prime UOM がインストールされているシステムの IP アドレスで

す。

– [User Name]：smuser と入力します。

– [Password]：デフォルトのパスワードは smuser です。

d. [SFTP Protocol] を選択します。

e. [Directory Path]：/home/smuser/ と入力します。

f. [Resend on failure] チェックボックスを選択します。

ステップ 5 [Add] をクリックします。

メディア サーバの SNMP サービス コミュニティ ストリング権限の設定

（注） この手順は、音声アプリケーション ソフトウェアを実行しているメディア サーバで実行します。

Prime UOM のインストールによってそのサーバに SNMP サービスがインストールされてイネーブルに

なっていることを確認します。

SNMP サービスのコミュニティ ストリング権限が none に設定されていると、Prime UOM はメディア 
サーバで稼働中のサポートされる音声アプリケーションを監視できません。コミュニティ ストリング

の権限が読み取り専用（read-only）、読み取りと書き込み（read-write）、または読み取りと作成
（read-create）に変更されないかぎり、SNMP クエリーは正常に実行されません。

ステップ 1 メディア サーバ システムで、[Start] > [Settings] > [Control Panel] > [Administrative Tools] > 
[Services] の順に選択します。

[Services] ウィンドウが開きます。

ステップ 2 [SNMP Service] をダブルクリックします。

[SNMP Services Properties] ウィンドウが開きます。

ステップ 3 [Security] タブを選択します。

ステップ 4 [Community String] を選択して、[Edit] をクリックします。

ステップ 5 権限を [NONE] から [READ ONLY] に変更します。

Prime UOM には、読み取り専用権限が必要です。権限を「読み取りと書き込み」または「読み取りと

作成」に設定する必要はありません。

Prime UOM に syslog レシーバを [Send Events] に設定

Prime UOM で、Cisco Unified Communications Manager、Unity Connection、または Unified 
Presence の syslog メッセージを正常に受信するには、デバイスの管理やサービスアビリティ Web ペー

ジで syslog レシーバを追加する必要があります。必要な手順を実行するには、次の手順を実行します。

[Service Down] イベントは、Prime UOM でサポートされる syslog イベントとして含まれます。

• 「Cisco Unified CM での syslog レシーバの設定」（P.2-31）

• 「Cisco Unity Connection の syslog レシーバの設定」（P.2-33）
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• 「Cisco Unified Presence の syslog レシーバの設定」（P.2-34）

Cisco Unified CM での syslog レシーバの設定

Cisco Unified Communications Manager の syslog メッセージを正常に受信するには、デバイスのサー

ビスアビリティ Web ページで syslog レシーバを追加する必要があります。

Syslog の処理では、Unified CM クラスタで次の登録されたエンティティを検出します。

• 電話、ボイスメールのエンドポイント、ゲートウェイなどに対する登録の変更。

• クラスタ内でプロビジョニングされた新しい電話。

プロビジョニングされた新しい電話は、既存のデバイス プールにプロビジョニングされている場合に

検出されます。そのクラスタに対するデバイス検出が終わった後で、クラスタに追加された新しいデバ

イス プールに電話を追加した場合は、[Run Now] を使用してこれらの電話を Prime UOM に表示する

必要があります。

どの syslog イベントが Unity Communications Manager のリリースにマップされるか、詳細について

は、[Fault Monitor] に一覧表示されているイベントを確認するか、表 E-2 を参照してください。

Cisco Unified Communications Manager に syslog レシーバを設定するには、次の手順を実行します。

ステップ 1 Cisco Unified Communications Manager で、デバイスのホーム画面の右上隅にある [Navigation] ド
ロップダウンから、[Cisco Unified CM Administration] を選択します。

ステップ 2 [System] > [Enterprise Parameters] を選択します。

ステップ 3 [Cisco Syslog Agent] セクションで、次の必須フィールドを更新します。

• [Remote Syslog Server Name] に Prime UOM  の IP アドレスを指定します。

• [Syslog Severity For Remote Syslog Messages] のドロップダウン メニューから [Informational] を
選択します。

ステップ 4 デバイスのホーム画面の右上隅にある [Navigation] ドロップダウンから、[Cisco Unified 
Serviceability] を選択します。

ステップ 5 [Alarm] > [Alarm Configuration] を選択します。

注意 Prime UOM の syslog を統合するために syslog の受信者を設定する際に、CCM エンタープ

ライズ サービス パラメータを使用しないでください。エンタープライズ パラメータがイ

ネーブルになっていると、Prime UOM が処理する予定であるかどうかにかかわらず、重大

度レベルが一致するすべての syslog メッセージが送信されます。
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ステップ 6 特定のマシンに対して正しいアラーム設定要素を（[Server]、[Service Group]、[Service]）を選択し、

[Go] をクリックします。たとえば、次のように入力します。

• Prime UOM サーバの名前とアドレスを [Server] テキスト ボックスに入力します。

• 次の表に基づいて、[Service Group] および [Service] オプションを選択します。

ステップ 7 [Enable Alarm] チェックボックスをクリックして、適切な [Alarm Event Level] を選択します。

Cisco.com の『Cisco Unified Serviceability Administration Guide for Cisco Unified Communications 
Manager』の「Alarm Configuration Settings」を確認します。

たとえば [Local Syslogs] の場合は、アラーム イベント レベルを [Error] に設定します。

ステップ 8 使用している Unified Communications Manager に基づいて、必要な情報を入力します。デバイス クラ

スタ検出またはリモート syslog 通知の場合は、アラーム イベント レベルを [Informational] に設定しま

す。

ステップ 9 [Apply to all nodes] をオンにします （サービスアビリティ ページの例については、図 2-3（P.2-33）を

参照してください。サービスアビリティの Web ページは、設定しているデバイスのバージョンによっ

て異なる場合があります）。

次の Unified 
Communications 
Manager バージョンの場

合 次のアラーム設定要素を選択します

4.x Cisco CallManager

5.1 • [Server] > [Service] > [Cisco AMC Service]

• [Server] > [Service] > [Cisco CDR Agent]

• [Server] > [Service] > [Cisco CDR Repository Manager]

• [Server] > [Service] > [Cisco CallManager]

• [Server] > [Service] > [Cisco Database Layer Monitoring]

• [Server] > [Service] > [Cisco DRF Client]

• [Server] > [Service] > [Cisco DRF Master]

6.x 以降 • [Service Group] > [CM Services] > [Service] > [Cisco 
CallManager]

• [Service Group] > [CDR Service] > [Cisco CDR Agent and 
Cisco CDR Repository Manager]

• [Service Group] > [Database and Admin Services] > [Cisco 
Database Layer Monitoring]

• [Service Group] > [Performance and Monitoring Services] > 
[Cisco AMC Service]

• [Service Group] > [Backup and Restore] > [Cisco DRF 
Client and Cisco DRF Master]

• [Service Group] > [Remote Syslogs]
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図 2-3 バージョン 6.0 の Cisco Unified Serviceability ページ

ステップ 10 [Save] をクリックします。

syslog メッセージは 1,024 文字までに制限されています（見出しを含む）。この syslog の制限のため、

syslog ベースのイベントの詳細に完全な情報が含まれない場合があります。syslog メッセージがこの

制限を超えた場合、syslog の送信者によって 1,024 文字に切り捨てられます。

Cisco Unity Connection の syslog レシーバの設定

Cisco Unity Connection の syslog メッセージを正常に受信するには、デバイスのサービスアビリティ 
Web ページで syslog レシーバを追加する必要があります。

どの syslog イベントが Unity Connection のリリースにマップされるか、詳細については、[Fault 
Monitor] に一覧表示されているイベントを確認するか、表 E-2 を参照してください。

Cisco Unity Connection で syslog レシーバを設定する手順は次のとおりです。

ステップ 1 Cisco Unity Connection で、デバイスのホーム画面の右上隅に表示されている [Navigation] ドロップダ

ウンから [Cisco Unity Connection Administration] を選択します。

ステップ 2 [System] > [Enterprise Parameters] を選択します。

ステップ 3 [Cisco Syslog Agent] セクションで、次の必須フィールドを更新します。

• [Remote Syslog Server Name] に Prime UOM  の IP アドレスを指定します。

• [Syslog Severity For Remote Syslog Messages] のドロップダウン メニューから [Informational] を
選択します。

ステップ 4 デバイスのホーム画面の右上隅にある [Navigation] ドロップダウンから、[Cisco Unity Connection 
Serviceability] を選択します。
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ステップ 5 [Alarm] > [Configuration] を選択します。

次のように特定のマシンに適したアラーム設定要素を選択します。

• Unity Connection 8.x の場合は次のように設定します。

– [Informational Alarms for Local syslogs] をイネーブルにします。

– [Informational Alarms Remote Syslogs] をイネーブルにして、Prime UOM Server の IP アドレ

スとしてサーバ名を入力します。

ステップ 6 [Save] をクリックして設定を保存すれば、syslog の設定は完了します。

Cisco Unified Presence の syslog レシーバの設定

Cisco Unified Presence の syslog メッセージを正常に受信するには、デバイスのサービスアビリティ 
Web ページで syslog レシーバを追加する必要があります。

どの syslog イベントが Unified Presence のリリースにマップされるか、詳細については、[Fault 
Monitor] または他のインターフェイスに一覧表示されているイベントを確認するか、表 E-2 を参照し

てください。

Cisco Unified Presence の syslog レシーバを設定するには、次の手順を実行します。

ステップ 1 Cisco Unified Presence で、デバイスのホーム画面の右上隅に表示されている [Navigation] ドロップダ

ウンから [Cisco Unified Presence Serviceability] を選択します。

ステップ 2 [Alarm] > [Configuration] を選択します。

ステップ 3 特定のマシンに対して正しいアラーム設定要素を（[Server]、[Service Group]、[Service]）を選択し、

[Go] をクリックします。たとえば、次のように入力します。

• Prime UOM サーバの名前とアドレスを [Server] テキスト ボックスに入力します。

• サービス グループの [CUP Services] を選択します。

• [Remote Syslogs] には、[Enable Alarms] を選択し、[Alarm Event Level] を [Informational] に設

定します。

ステップ 4 [Save] をクリックして設定を保存すれば、syslog の設定は完了します。

Unity Event Monitoring Service の設定

Event Monitoring Service（EMS）は、Remote Serviceability Kit とともにインストールされている必

要があります。

Event Monitoring Service を設定して、Prime UOM で、これらの Unity イベントをサポートするには、

次の手順に従います。

• OutOfDiskSpace：イベント ソース：ESE、イベント ID：482。

• HardDiskError：イベント ソース：Cissesrv、イベント ID：24600。

• ExchangeLoginFailed：イベント ソース：CiscoUnity_Doh、イベント ID：32013。

これらのイベントの詳細については、「サポートされるイベント」（P.E-3）を参照してください。
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Event Monitoring Service を設定するには、次の手順を実行します。

ステップ 1 デスクトップの [Tools Depot] を開き、[Diagnostic Tools] > [Event Monitoring Service] を選択します。

ステップ 2 ダブルクリックして実行します。

ステップ 3 通知を受信する受信者を作成します。[File] > [New] > [Recipient] を選択するか、ナビゲーション ツ
リーの [Recipients] ノードを選択して、[Create New Recipient] をクリックします。

ステップ 4 [Recipient Name] に入力して、受信者を 1 人指定します（あるいは [SMTP] の下に複数の電子メール 
アドレスを指定してグループを指定します）。

ステップ 5 任意の通知方法タブを選択します。

• SNMP トラップのタブは、Remote Serviceability Kit と連携して、トラップ（Windows の SNMP 
サービス プロパティで定義）を宛先に送信します。

• syslog のタブでは、イベントに対して Syslog サーバのアドレスを入力できます。

• フェールオーバーのタグは通知ではありませんが、特別なイベントを受信したときにフェールオー

バーの強制的な実行を指定できます。

ページの上部にある [Test] ボタンを使用すると、定義した受信者にテスト イベントが送信されます。

これらの内容は次のとおりです。

• イベント ソース：EMSTest

• イベント ID：10001

• 説明：Event Monitoring Service のテスト メッセージ

ステップ 6 監視するイベントを作成します。[File] > [New] > [Event] を選択するか、ナビゲーション ツリーの 
[Monitored Events] ノードを選択して、[Create New Event] をクリックします。

イベントが現在 Windows Event Viewer にある場合は、次の手順に従って、[Add New Event] ダイアロ

グにそのイベント情報を入力してください。

• Windows Event Viewer でイベントを選択します。

• [Copy Event to Clipboard] を選択します。

• [Add New Event] ダイアログの [Import Event From Clipboard] を使用します。

手動でイベントを追加する手順は次のとおりです。

ステップ 1 プルダウン メニューから [Event Source] を選択します。

ステップ 2 [Event ID] を選択して、任意の ID を入力します。[All Event IDs] を使用して、指定したイベント ソー

スからのすべてのイベントを対象にすることもできます。

ステップ 3 [Type] を選択して、送信する必要のある通知レベルをフィルタします。

ステップ 4 すべてのレベルのイベントおよび [Type] が unknown のイベントに対して [Errors]、[Warnings]、およ

び [Informational] を選択します。    

ステップ 5 [Notes] に、トラブルシューティングの手順など、通知に含める情報を入力します。

コンテンツ セクションには、[Recipient Voicemail] オプションを使用するイベント用にカスタマイズ

した WAV を登録できます。

[Email Subject and Body] は、[Recipient Email] に対して送信されるメッセージの形式および SMTP 通
知方式をカスタマイズするために使用します。カスタマイズが不要の場合は、デフォルトのままにして

おきます。
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ステップ 6 新しいイベントを追加したら、[OK] を選択します。

新しいイベントを有効にするには、1 人以上の受信者を追加する必要があります。

ステップ 1 新しく追加したイベントを選択して、[Add Recipients] アイコンをクリックします。[Recipients] と通

知方式は、チェックボックスを使用して細かく定義できます。

ステップ 2 [Active] チェックボックスをチェックし、[Apply] をクリックしてイベントを有効にします。

この手順は、ナビゲーション ツリーの [Monitored Events] ノードから実行することもできます。

他の基準を満たすイベントを除外または無視することもできます。その場合は、[File] > [New] > 
[Exclusion] を選択するか、ナビゲーション ツリーの [Exclusions] ノードを選択して [Create New 
Exclusion] をクリックします。

イベントが現在 Windows Event Viewer にある場合は、[Add Exclusion] ダイアログにそのイベント情

報を入力できます。その場合は、Windows Event Viewer でイベントを選択し、[Copy Event to 
Clipboard] をクリックします。[Add Exclusion] ダイアログで、[Import Event From Clipboard] を使用

します。

手動でイベントを除外する手順は次のとおりです。

ステップ 1 プルダウン メニューから [Event Source] を選択します。

ステップ 2 [Specific Event ID] を選択して、任意の ID を入力します。[All Event IDs] を使用して、指定したイベ

ント ソースからのすべてのイベントを対象にすることもできます。

ステップ 3 新しい除外対象を追加し終えたら、[OK] を選択します。

Cisco Unified CM での RTMT の設定 
Prime UOM は、RTMT と同じポーリング レートとしきい値の設定を使用します。通常の操作では、何

もする必要はありません。デフォルトで適切に機能します。

（注） この設定は、Unified Communications Manager（Unified CM）のパフォーマンスと Prime UOM に影

響します。

ポーリング レートを低くする場合は、リアルタイムで監視するポーリング レートを高くし、Unified 
CM のパラメータ設定を更新して、次の手順を使用します。

• ポーリングとしきい値のパラメータ設定を更新するには、Unified Communications Manager 
Administration ページに移動します。

• CallManager 6.x 以降のポーリング レートを変更するには、[System] > [Service Parameter] > 
[publisher] > [Cisco AMC Service] を選択して、[Data Collection Polling] のレートの値を変更しま

す。

• しきい値のパラメータを変更するには、RTMT をインストールして起動し、[AlarmCentral] を選

択し、特定のアラートを選択し、右クリックして Alert Property を起動します。
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Cisco Unified CM での HTTP クレデンシャルの設定

Prime UOM は、SNMP の他にも AVVID XML Layer（AXL）API を使用して Cisco Communications 
Manager を管理します。これは、Prime UOM が AXL インターフェイスを使用して HTTP 経由で 
SOAP を呼び出し、Cisco Unified Communications Manager からエラー情報やパフォーマンス情報を

収集することを意味しています。これらの照会を実行するために、 Prime UOM には HTTP ユーザ名と

パスワードが必要です。

このユーザ名とパスワードには管理者特権は必要ありません。http://server-name/ccmadmin に対する

読み取りレベルのアクセスを持つクレデンシャルが必要です。

Cisco Unified Communications のデバイスの DNS 設定

Prime UOM では、Unified CM の名前をドメイン ネーム サービス（DNS）で解決できないと、正しい

モニタリング情報を収集できません。

デバイス名が解決可能であることを確認してください（フォワードとバックワードの両方）。

DNS については、次のことに注意してください。

• デバイスが IP アドレスだけで設定されている場合、DNS 設定は問題になりません。

• デバイスが DNS 名で設定されている場合は、DNS サーバによって名前が解決されます。

• デバイスは syslog を Prime UOM サーバに送信するよう設定する必要もあります。手順の詳細につ

いては、「Cisco Unified CM での syslog レシーバの設定」（P.2-31）を参照してください。

• DNS 解決についての詳細は、「DCR へのデバイスの追加」（P.8-8）と、Cisco.com にある

『Deployment Guide』を参照してください（URL：
http://www.cisco.com/en/US/products/ps6535/prod_white_papers_list.html）。

イベントの表示
[Unified Dashboard] 画面を使用してイベントを表示できます。Unified Dashboard から [Diagnostics] 
タブを選択して、任意のビュー表示からイベント情報を参照します。 

他にも、次の場所でイベントが表示されます。

• Fault Monitor

• レポート

• Service Level View
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